
 

   

Using the Sequencer on Tektronix AWG 
70000A Series Instruments

 
Arbitrary Waveform Generators (AWGs) are one of the most versatile and useful test and measurement 
products used today. With an AWG users can create real world signals that enable engineers to re-create 
anomalies and test signals that are difficult or impossible to reproduce. AWGs can also be used to mimic 
environments that enable engineers to test complex scenarios that would require multiple test benches filled 
with equipment or costly live interactions with other electronic devices. One of the features available on an 
AWG is the sequencer. The sequencer mode allows users to string multiple waveforms together enabling very 
complex waveform generation. The sequencer also allows for branching and looping features that enable 
waveform generation without the need for extremely large memory requirements or external program control. 
In order to use the sequencer efficiently some basic understanding of how it works will greatly increase its 
usefulness. Some of the more common applications that the sequencer is used in are: 

Radar – Used for simulation of transmitters and reflections to verify that the receiver can identify many different 
types of reflections and moving objects. 

Serial Data Testing – Many serial data standards (USB, SATA, PCIE and others) require that the test 
instrumentation be able to put the Device Under Test (DUT) into a test mode or loop back mode in order to 
validate the device and do compliance testing. With the sequencer, the user can provide the signals required to 
put the device in loopback or test mode and then jump right to the stressed waveform in order to do the 
compliance or margin testing. 
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Manufacturing and Test – Many electronic manufacturing facilities need to automate complex testing 
scenarios where many different types of stimulus or waveforms are required in order to evaluate the 
performance of the DUT. These tests need to be done repeatedly and as fast as possible. Since the sequencer 
can have many waveforms loaded into memory the test time doesn’t require the loading of each individual 
waveform during the test, thus enabling the fastest testing times possible. 

In order to use the sequencer on the AWG70000 series there are two requirements regarding waveform 
creation. 

1. The waveform length needs to be at least 2400 points on the AWG70002A and 4800 points on the 
AWG70001A instruments. 

2. The total waveform length needs to be divisible by the granularity of the sequence buffer.  This is not a 
factor on the AWG70002A but is 2pts on the AWG70001A.  

With care in waveform creation, the sequencer can provide very useful waveform generation especially when 
you consider all the standard features that are available.  

 Maximum sequencing steps: 16,383 
 Wait 

Allows the sequence to wait at the defined sequence step until an external trigger arrives using the 
Trigger A or B input on the rear panel of the AWG, the front panel Trigger A or B buttons, the 
instrument’s internal trigger, or through program control. This mode is enabled by setting the Wait 
field in the sequence configuration to the desired trigger event (Trigger A, Trigger B, or Internal). 
Once it gets the trigger event, the sequence will play that waveform. 

 Flags 
Allows up to 4 signals per channel that can be set for a High, Low, Toggle or Pulse from the SMB 
connectors on the rear panel of the instrument. 

 Repeat 
The waveform repeats from 1- 1048576 times or infinitely.  

 Event Jump 
Allows a sequence to run a waveform until an external trigger arrives using Trigger A or B, using the 
instrument’s internal trigger, or through program control. This mode is usually used with the repeat 
count set to infinite, such that a waveform will continuously run until an event comes in and then it 
will jump to a defined index. Event jump also allows the user to specify whether the sequence 
should jump as soon as it gets an event or wait until the waveform is finished before it jumps to the 
next defined index. 

 Go To 
This allows the user to define which index the sequencer will go to after the current waveform has 
finished. This is useful to run the whole sequence in a loop where go to is defined as 1 so the 
sequence will start over. 

 Sub Sequencing  
A subsequence is a sequence of waveforms with an optional repeat count that you can create and 
put into a sequence index. This allows the user to define a sub sequence that could be used 
several times within the main sequence, thus eliminating the need to repeat a particular set of 
waveforms individually.  

 Pattern Jump 
Pattern Jump allows the user to jump to a specified position in a sequence, depending on the user-
defined jump table definition and using the external Pattern Jump input on the rear of the 
instrument. This allows up to 256 different addresses that can be used for specific jump index 
locations. 
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Creating a Sequence 

Use the Sequence tab to create a new sequence or edit existing sequences.  

Creating a sequence is as easy as dragging and dropping a waveform from the waveform list into the desired 
Track and sequence step. Then continue building your sequence by assigning waveforms (or other defined 
sequences) to successive steps. By default, each step of a sequence plays in numerical order. When the 
sequence reaches the final step, the sequence naturally ends and the AWG stops transmitting.  

 

Sequence editor 
toolbar Item 

Description 

Step number 
column  

The first column in the Sequence editor contains the numbered steps. These step 
numbers define the play sequence and are used as the targets for the Event Jumps, 
Pattern Jumps, Force Jump, and Go to features.  

The maximum number of steps allowed in a sequence is 16,383. This includes steps 
contained within subsequences. For example, a sequence numbering to 1000 steps 
would actually have 1500 steps if a subsequence of 500 steps is part of the sequence.  

When using a subsequence, the steps in the subsequence are only counted one time, 
meaning that you can reference the same sequence multiple times without increasing 
the step count multiple times.  
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Wait Defines the condition required for the step to start playing the assigned waveform.  

 Off: No waiting, the waveform plays immediately. 

 Trig A: The step does not start until a trigger signal is received on the Trigger A 
input or a Force Trigger A event is received.  

 Trig B: The step does not start until a trigger signal is received on the Trigger B 
input or a Force Trigger B event is received.  

 Internal: A jump occurs when the internal trigger event occurs.  

Track 

 

The Track columns contain the name of the waveform or subsequence to play at each 
step.  

 To load a waveform into a step, open the Waveform List, select a waveform and 
drag the waveform into the Track column at the specified step number.  

 To load a subsequence into a step, open the Sequence List and drag a sequence 
name in the Track step. This sequence now becomes a subsequence.  

 Once a waveform or sequence is assigned to a step, you can use the copy and 
paste functions to populate other steps within the sequence.  

 To add a new track, Right-click on any of the Track column headings and select 
Add Track. A new track is added after the last track.  

 To remove a track, right-click on the Track column you want to remove and select 
Remove Track.  

 To play a sequence track, you must assign the track to a channel, even if there is 
only one track in the sequence. Use the Home tab to assign sequence tracks to 
channels.  

Flags 

 

The Flags column allows you to place indicators (flags) within a sequence to provide a 
status of the sequence. The flags are an output to the Flag Outputs on the rear panel.  

Repeat The Repeat Count column defines how many times the waveform or subsequence 
assigned to a specific step in the sequence.  

<enter count>: Enter the number of times to repeat the waveform. The maximum repeat 
count for a step is 1048576.  

 Use infinity to continuously play the waveform until a jump condition occurs.  

 1: The waveform plays one time. 
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Event Input Defines the event which will cause a jump to occur in the sequence step. If an event 
triggers a jump, the sequence uses the Event Jump definition and skips the Go to 
definition.  

 Off: A jump is not active for the step. Off is the default setting.  

 Trig A: A jump occurs if a trigger signal is received on the Trigger A input or a 
Force Trigger A event is received. Otherwise, the sequence uses the Go to 
definition.  

 Trig B: A jump occurs if a trigger signal is received on the Trigger B input or a 
Force Trigger B event is received.  

 Internal: A jump occurs when the internal trigger event occurs.  

Event Jump To Defines which step to which the sequencer jumps when the Event Input condition is met. 

The Event Input condition must be set before you can define the jump.  

  <enter step>: Enter the step number to jump to if the Event Input condition is met.  

 Next: The sequencer jumps to the next step in the sequence. 

 First: The sequencer jumps to the first step in the sequence. 

 Last: The sequencer jumps to the last step in the sequence. 

 End: The sequence ends. The Analog and Marker outputs are set to the values 
defined in Output Options dialog screen.  

Go To Defines the next step in the sequence to play when the step has finished playing its 
waveform. This is where the sequence continues if no other defined events occur.  

  <enter step >: Enter a specific step in the sequence to jump to.  

 Next: The sequence goes to the next step in the sequence. This is the default 
setting. If Next is chosen for the last step in the sequence, the sequence ends.  

 First: The sequence jumps to the first step in the sequence.  

 Last: The sequence jumps to the last step in the sequence.  

 End: The sequence stops when finished with this step. 

Length Displays the size of the waveform assigned to the step.  

NOTE. The Length display becomes invalid if the sequence has more than one track and 
the waveforms assigned to the step are different sizes. If you attempt to play multiple 
tracks of a sequence on a two channel instrument, each step of the tracks must use 
identical length waveforms.  

Time The displayed time is based on the waveform size, sample rate, and the repeat count.  If 
infinite is used for repeat count the time value will not be displayed. 

NOTE. The Time display becomes invalid if the sequence has more than one track and 
the waveforms assigned to the step are different sizes.  
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Sequence settings 
The sequence settings dialog box provides the following settings:  

 Jump Timing – Determines when an event jump in the sequence occurs.  

 Enable Pattern Jump – Enables the pattern jump event feature. A jump occurs when the system 
detects a defined digital pattern on the Pattern Jump connector on the rear panel. Use the Edit pattern 
jump table button to display the pattern jump table editor.  

 Recommended Sample Rate – Automatically determines the sample rate to be used when running the 
sequence. This is the recommended sample rate and the instrument will attempt to use this rate if the 
Manage Conflicts field (in the Clock setup menu) is set to Auto.  

 Repeat Flag – Causes the flag (or flags) for that step to repeat if the sequence step is set to repeat 
(using the Repeat Count setting). The default setting is off (not enabled). This means that the flags are 
set the first time the waveform is played for a sequence step. Repeating the step will not cause the flag 
to repeat.  

When enabled, the flag is set each time the waveform plays for each time the step is repeated. NOTE. 
The Repeat Flag feature is only useful when using the Toggle or Pulse flags. Since flags remain in their 
set state (unless changed by another step or the sequence ends), repeating a high or low flag would 
not cause any change to the flag output.  

Jump Timing 
Jump Timing determines when an event jump in the sequence occurs. This affects all types of event jumps. 
You can access the Jump Timing settings in two ways: either from the Sequence Settings dialog screen in the 
Edit menu or directly from the Jump button.  

Jump immediately – A jump occurs immediately at the time the jump event occurs, stopping the playback of 
the waveform currently playing.  

Jump at end of waveform – A jump occurs only after the currently playing waveform completes its playback. 
If the waveform is defined to repeat (using the Repeat Count setting in the Sequence editor), the end of 
waveform occurs when the waveform finishes its current cycle.  

Jump execution order 
There are a number of ways that a jump can be initiated in a sequence. Some types of jumps take precedence 
over other types of jumps.  

Below is the order in which jumps are executed by the system. 

1. Force Jump – Pressing the Force Jump to... button (from the Home tab) allows you to initiate a jump 
anytime anywhere within the sequence. A force jump takes precedence over all other types of jumps 
regardless of the current step of the sequence.  

2. Pattern Jump – If Pattern Jump is enabled and the defined pattern occurs, this jump takes precedence 
over the Event Jump or Go to jump. The Pattern Jump is independent of any step of the sequence.  

3. Event Jump – If an Event Jump is defined for a step, this jump takes precedence over the Go to jump.  

4. Go to Jump – Go to is the default jump destination for a step if no other jumps occur.  

NOTE. All jump types are dependent on the Jump Timing setting, either causing the jump to occur 
immediately or at the end of the waveform currently playing.  
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Creating a Pattern jump 
Pattern Jump is another type of event jump to cause a change in the sequencing of waveforms when an 
external digital pattern is applied to the Pattern Jump In connector on the rear panel.  

As with any other event jump, Pattern Jump allows you to jump to a specified position in a sequence.  

To define the pattern, display the pattern jump table. The Pattern Jump editing table is available from the 
Sequence Settings dialog screen (from the Edit button menu) and the Jump button in the Sequence tab. 

 

Use the Pattern Jump Table to select the input patterns to use to initiate a jump. There are 256 Input Patterns 
that are predefined and are not editable. To use the table, simply go to a corresponding input pattern and 
select the step in the sequence you want the sequence to jump to when the pattern is applied to the Pattern 
Jump In connector.  

A strobe signal is used to control the pattern input. Patterns are clocked in on the falling edge of the strobe 
signal.  

NOTE. Be sure to assign valid step numbers in the “Jump to Step” column.  
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Pattern Jump Connector Specifications: 
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Sequence Flags 
Sequence flags provide the user up to four signal outputs per channel  as a sequence step indicator to help 
identify the state of the sequence. And since flags are not part of a waveform file (unlike Markers), the flag 
waveforms use the full resolution of the instrument.  

A flag can be placed on any step within a sequence track. The flag signals the start of the waveform playback 
for that sequence step. So if there is a wait condition, the flag is not set until the condition is met.  

The flags column is divided into four sections, corresponding to the four outputs available (A, B, C, D). To help 
identify the flag locations, the following illustration shows that a flag has been set in each possible location.  

To set a flag, either touch or double click on the flag cell. The following dialog appears: 

 

There are four flag outputs (A, B, C, D) available for each channel. The flag outputs are located on the rear 
panel (Flag Outputs).  

Each flag has the following possible states: 

 No Action: This is the default state 
for all flags. The flag output is at 0 V 
at default.  

 High: The designated flag output is 
set to high (3.3 V into 50 Ω).  

 Low: The designated flag output is 
set to low (0 V). 

 Toggle: The designated flag output 
toggles from its previous state, from 
High to Low or Low to High.  

 Pulse: A pulse is sent to the 
designated flag output. The pulse 
direction is determined by the 
current state of the flag output. If the 
current state is low, the result is a 
positive pulse. If the current state is 
high, the result is a negative pulse.  

NOTE. The pulse width is determined by the sample rate with the formula: 600/Sample Clock (The sampling 
clock frequency is displayed on the clock settings tab when the external clock output is enabled).  

Flag outputs remain in their set state until the sequence ends or the flag is set again by another sequence 
step. You can quickly disconnect the flag outputs using All Outputs Off, either in the graphical interface or with 
the front panel button. (The output connectors are electrically floating while all outputs off is engaged.) All flag 
outputs are terminated into 50 Ω and have short circuit protection to ground.  

NOTE. Be careful when defining flag outputs. It’s possible to redefine a flag’s output within the same 
sequence, easily leading to undesired results.  
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Sequence flag timing 
A sequence flag is initiated by the start of the waveform playback associated with the step. The flag is set 
before the waveform playback begins. The timing of the waveform playback from a flag’s transition change is 
illustrated below, followed with the formulas to calculate the delays.  

Flags also have a repeatability window. This means there may be a slight difference in the delay time of a 
flag’s transition in successive changes. See the timing illustration below to help explain these delays.  

 

 

Flag timing calculations 
Use the formulas below to calculate the actual flag delay and flag repeatability window.  

 Flag to Analog output delay (tf): 
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Subsequences 
Subsequences are simply a sequence that is inserted as part of another sequence. This feature allows the 
user to embed another sequence of steps into a main sequence, thus making the sequence much easier to 
view and effectively reducing the number of steps required.  

There are two methods to edit a subsequence: 

 Open the sequence to be used as a subsequence directly from the Sequence List. This opens the 
sequence in the main sequence editor.  

 Open the subsequence from within the main sequence. When a sequence is being used as a 
subsequence, a subsequence editor is provided. The subsequence editor provides you with only the 
functions subsequencing supports.  

To edit a subsequence with the subsequence editor, display the main sequence in the Sequence window. 
When a sequence is being used as a Subsequence, an arrow icon is displayed in the step number. Touch and 
hold or double-click the icon to display the subsequence editor.  

Subsequence editing is performed the same as editing any sequence, but with the following limitations:  

 Subsequences do not use 
any Wait conditions. If a wait 
condition is built into a 
sequence, the wait conditions 
are ignored if the sequence is 
used as a subsequence.  

 Subsequences do not 
support Event Jumps or 
Pattern Jumps. If a jump is 
built into a sequence, the 
jumps are ignored if the 
sequence is used as a 
subsequence.  

 You cannot jump or go to a 
step in the main sequence 
from a subsequence.  

 If the subsequence uses a 
step definition of End (end of 
sequence) in the Go to 
column, it is redefined as 
Last (last step of the 
subsequence)  

 If a sequence containing wait 
conditions and jump 
conditions is used as a 
subsequence, the wait 
conditions and jump 
conditions are ignored. 

 The sequencer ignores any 
Go to command in the last 
index of a subsequence and 
automatically exits the subsequence. 
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Batch Sequence Compiler 
The batch compiler provides a method to create sequences outside of the AWG70000 Series application using 
an Excel spreadsheet (.CVS file type). The comma delimited file type (.CSV) must be used.  

To import the batch compiler file, you must use the Open File menu from the toolbar. Opening the file compiles 
all defined waveforms and loads the sequence into the Sequence List and loads all waveforms into the 
Waveform List.  

Creating a batch compile file (.CSV) 

The .csv file must be created with very specific information in the proper cells. Deviating from this design will 
likely create an invalid file. Following defines the rows, columns, and cell content required to create the batch 
file.  

Header information. The first four lines in column A must use the content as shown.  

Batch compiler 
header information 

Line 

Column A Column B 

Line 1 AWG 
Sequence 
Definition 

blank 

Line 2 Sequence 
Name 

Enter a name for your sequence. If omitted, the system will generate 
a unique name.  

Line 3 Sample Rate Enter the sampling rate to use. If omitted, the system calculates the 
sample rate based on the waveform frequency specified.  

Line 4 Waveform 
Name Base 

Enter the base name for the waveform files. Use the following 
syntax: 

<base name> [#Frequency_#Length_#Marker1_#Marker2] 

The base name is used for all waveforms. Optionally, you can 
include the additional waveform information.  

If omitted, the system will generate unique names. 
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Track information. Following the header information is the start of the track definitions. You can create up to 
eight tracks containing multiple waveforms.  

Each new track definition must start by creating a row with the name “Track” in cell A. This is where the 
definition of the track begins. The following row contains the headings for the waveform parameters. The rows 
following the parameter headings are the waveform definitions. The waveform definitions continue for the 
Track until another “Track” row is encountered.  

Batch compiler header 
information Column 

    

A Wait Optional wait condition. 

Defaults to Off if not specified. 

B Repeat Optional repeat element. 

Defaults to 1 if not specified. 

C Event Input Optional event input. 

Defaults to Off if not specified. 

D Event Jump to Optional event jump. 

Defaults to Next if not specified. 

E Go To Optional go to element. 

Defaults to Next if not specified. 

F Flags Optional flag element. 

Defaults to No Change if not specified.  

G Waveform Name Optional waveform name. This supersedes the Waveform Name Base in the 
header information.  

If omitted, the Waveform Name “Base” is used.  

H Frequency Specifies the frequency of the waveform to be compiled. 

I Length Specifies the length in sample points of the waveform to be compiled. 

If omitted, the system calculates the length. 

J Marker1 Optional marker1 value. 

Defaults to 0 if not specified. 

K Marker2 Optional marker2 value. 

Defaults to 0 if not specified. 

L Editor Optional Editor to use to compile waveform.  

If Editor is defined as Basic Waveform, then the following waveform parameters 
can be defined.  

MNO Parameters Function: Defines the type of waveform to create. Defaults to Sine Wave.  

Amplitude: Sets the peak-to-peak amplitude. Defaults to 500 mVpp.  

Offset: Set the offset. Defaults to 0 V. 
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Spreadsheet example
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Creating legacy .SEQ files  

Many users would also like to create a sequence file that can be imported into the AWG70000A series. Listed below is an 
explanation of the format required to do this. 

Name of example file  ‐ Main.seq 

File Content: 

MAGIC 3002A    *header line MAGIC 300x (where x = 1, 2, 3, or 4 indicating the number of channels 

LINES 4                 * Specifies how many Sequence Indices are used                                                              

"sine.wfm","",10,1,0,2,3               * 1st Sequence line 

"triangle.wfm","",5,0,0,3,4          * 2nd Sequence line 

"square.wfm","",3,0,0,4,2            * 3rd Sequence line 

"subseq.seq","",5,0,0,1,1             * 4th Sequence line – calls a sub sequencing 

TABLE_JUMP 0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0 

LOGIC_JUMP ‐1,‐1,‐1,‐1 

JUMP_MODE SOFTWARE 

JUMP_TIMING ASYNC                                                    

STROBE 0 

Line by Line Description 

MAGIC 3002A    *header line MAGIC 300x (where x = 1, 2, 3, or 4 indicating the number of 
channels.                                                                                                                                                                                                          

LINES 4 * Specifies how many Sequence Indices are used 

(* Sequence Line Definition*) 

(*Six fields delimited by comma – for two channel system*) 

(*      F1                  F2                           F3                          F4                           F5                           F6                           F7) 

(* “Wfm ch1”,   “Wfm ch2”,    Repeat Cnt,             Wait for Trig,       Goto One,           Event Jump        Goto N) 

"sine.wfm",        "",                           10,                          1,                            0,                            2,                            3 

"triangle.wfm", "",                           5,                            0,                            0,                            3,                            4 

"square.wfm",  "",                           3,                            0,                            0,                            4,                            2               

"subseq.seq",   "",                           5,                            0,                            0,                            1,                            1               

F3: Repeat Count: Sets repeat count field – 1 to 65536, 0 sets infinity 

F4: Wait Trigger.       0‐off/1‐on For an ON line, the instrument awaits the trigger before the waveform is output. 

F5: Goto One: N/A 

F6: Event Jump. When the combination of the event signals connected to the EVENT IN connector on the rear panel 
goes TRUE during waveform output of the line, the control jumps to the specified destination. This also happens when 
you push the FORCE EVENT button on the front–panel. 

F7: Goto <N>. If you enter the number, the control jumps to the specified sequence after the current signal is 
output.                                                                                                                                                                                                           
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TABLE_JUMP 0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0 

LOGIC_JUMP ‐1,‐1,‐1,‐1 

JUMP_MODE SOFTWARE 

JUMP_TIMING ASYNC                                                                                                                                                                    

STROBE 0 

Sub‐Sequence File: Subseq.seq 

MAGIC 3002A                                                                                                                                                                                     

LINES 3                                                                                                                                                                                                  

"sine.wfm","",10,1,0,2,3 

"triangle.wfm","",5,0,0,3,1 

"square.wfm","",3,0,0,1,2 

TABLE_JUMP 0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0 

LOGIC_JUMP ‐1,‐1,‐1,‐1 

JUMP_MODE SOFTWARE 

JUMP_TIMING ASYNC                                                                                                                                                                    

STROBE 0 

 
Conclusion 
As you can see from this document, the sequencer option on the AWG70000A series enables and improves 
waveform output capabilities dramatically. Not only does it allow the user to run a series of waveforms 
automatically but it also allows for complex/pattern jumping, flag outputs, subsequences and batch compilation. 
The uses for this option are without a doubt one the main features of the AWG70000A series that which set it 
apart from other AWG products. 


